
file://C:\TEMP\~hhB445.htm

Tuesday, August 29, 2000 09:47:27 1 of 27

Part IV: Troubleshooting NetMeeting

Chapter 15 

Troubleshooting Audio
In this chapter, you will learn: 

l All about general audio problems. Audio can be difficult to set up because of the vast assortment of problems that can 
arise. I'll show you the most common problems and how to solve them. 

l Full-duplex. This allows your computer to play and record at the same time, which is required for the full telephone-like 
operation of NetMeeting's audio features. 

l Improving the quality. Learn how to improve the quality of NetMeeting's audio features. 

As explained in Chapter 6, your ability to use NetMeeting's audio features depends on your sound card, network connection 
capability, the available bandwidth, and configuration options. All of these elements must be set properly and must function 
correctly for you to use NetMeeting's audio capabilities effectively. In most cases, if your sound card already works with Windows, 
you won't have any trouble with NetMeeting. However, many of you may be using a microphone with your computer for the first 
time, and that can cause some problems. 

This chapter is designed to help you solve any problems that you may have with NetMeeting's audio features. If your audio is 
working properly, you don't need to refer to this chapter. However, both participants in a NetMeeting connection must have their 
audio working properly. This adds a level of complexity: although your system may be working fine, if the other person is having 
problems, you may experience them as well. 

This chapter looks at the most common problems and solutions to using NetMeeting's audio features. Some issues, such as 
hardware compatibility and sound card driver capability, are outside the scope of this chapter. For these problems, you may have to 
contact the hardware manufacturer for updated software and information about the problem. Most manufacturers offer free 
software updates on the Internet. 

Microsoft has included an audio troubleshooting guide with NetMeeting. This may help you solve any problems. To view the 
online help for audio problems, follow these steps: 

1. In NetMeeting, click Help from the main menu. 

2. Select Help Topics. 

3. On the Contents tab, select Troubleshooting and click Open. 

4. Select "If you have trouble using NetMeeting" and click Display. 

5. Finally, click "I'm having trouble using the audio features" and follow the online instructions. 

Before you continue reading this chapter, you may want to check some of the most common reasons why the audio may not be 
working on your computer: 

l Are the speakers plugged into the sound card and do they have power? 

l Is the microphone plugged in? 

l Do you have a Windows-compatible sound card installed in your computer? 
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l Are the drivers for the sound card installed properly? 

l Do you have the most recent drivers from the manufacturer for your sound card? 

l Have you turned on the audio features? 

l Does your connection support the TCP/IP protocol? (If you are using the Internet, the answer is yes.) 

l Does the computer to which you are connected have properly working audio? 

Solving General Audio Problems
To troubleshoot audio problems with NetMeeting, you should identify the problem, go through each item in this chapter, and 
follow the instructions provided under each topic. In some cases, several troubleshooting items may help you get NetMeeting's 
audio feature working. If you are unable to use NetMeeting's audio features, first check the most common reasons discussed in this 
chapter. Verify that the other computer to which you are connected can use its audio features, and make sure that you are not 
hosting a conference and did not place a data-only call. These are just a few of the reasons why you may not be able to use audio. 
NetMeeting also provides the Audio Tuning Wizard for diagnosing audio problems. You can access the Audio Tuning Wizard 
from the Tools menu. 

NetMeeting attempts to use the audio features by default when you place a call. You can change that behavior, however, by using 
the Advanced Calling command on the Call menu and specifying that the audio features should not be used for a particular call. 
Keep in mind that once you participate in a meeting that does not have audio features enabled (because it was started as a data-only 
call), you will not be able to use the audio features without restarting the meeting. 

Trying to Include More Than Two Participants

One limitation of NetMeeting's audio features is that it will only work between two people without the use of an external 
conferencing server. If more than two people are participating in a meeting, only the first two who joined the meeting are able to 
use the audio features. If you were not one of the first two people to join the meeting, then you must restart the meeting to use 
audio. In the future, multipoint audio and video will be added to NetMeeting to overcome this limitation. 

Connecting to Someone Who Can't Use Audio Features

If you connect to a computer that cannot use NetMeeting's audio features, you will be unable to use audio too. Both computers 
must have fully functional audio equipment and must be configured properly. 

If you think your audio may not be working because of the computer you're connected with, connect to another computer that you 
know can use NetMeeting's audio features. If you are then able to use the audio features, the problem obviously comes from the 
computer that you were originally connected with. That computer must resolve its audio difficulties for you to exchange audio with 
it. 

Hosting a Conference

If you are hosting a NetMeeting conference, you cannot use NetMeeting's audio features. There is no way around this; it is part of 
the way NetMeeting works. In this case, you can only regain audio capability by ending the conference and starting another 
meeting. When you reconnect, remember not to host a conference if you want to use the audio features. 

Giving Audio Control to NetMeeting

Once a program has taken control of your sound card, other programs cannot use it. Therefore, if you are using NetMeeting's audio 
features, other programs will not be able to use the sound card. It also works in reverse: if another program has taken control of the 
sound card, you will not be able to use NetMeeting's audio features. 
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When NetMeeting is running on your computer and its audio features are enabled, your computer may experience one or more of 
the following symptoms: 

l Sounds assigned to events in Windows 95 do not play when the corresponding event occurs. 

l If you double-click the Sounds icon in Control Panel and attempt to manually play a sound associated with an event, the 
following error message is displayed: "Windows cannot play the sound <filename>. Your sound card may be in use." 

l If you attempt to play a WAV file in Sound Recorder, the following error message is displayed: "Another application is 
playing audio. You can either interrupt the application or wait until it is done. Then try using Sound Recorder again." 

You are not able to play WAV files in Windows when NetMeeting is running on your computer and its audio features are enabled. 
You can get around this by disabling NetMeeting's audio features—click the check boxes on the Audio toolbar to clear them. If the 
Audio toolbar is not visible, click Toolbar on the View menu. 

Running the Audio Tuning Wizard Without a Microphone

The Audio Tuning Wizard will run even if you have not installed a microphone on your computer. It is necessary for NetMeeting 
to run the Audio Tuning Wizard to assess the functionality of your computer's sound card. This wizard helps set volume and 
sensitivity that affect the exchange of audio during a connection and is run automatically the first time that you run NetMeeting on 
your computer. You can click Cancel to stop the Audio Tuning Wizard during installation. Once you have installed a microphone, 
you can run the Audio Tuning Wizard manually (from the Tools menu) to adjust the microphone settings. 

Changing Volume

When you begin NetMeeting, the speaker level volume may be different than it was the last time you used NetMeeting. This is 
because the master system volume setting in Windows changed since you last used NetMeeting. Most applications, including 
NetMeeting, share the same master volume settings. The speaker volume control in NetMeeting merely adjusts the master system 
volume. When NetMeeting starts, the master volume setting is inherited from any other applications or manual changes that you 
have made to the speaker volume, so NetMeeting does not remember its last setting. You can return the volume to an acceptable 
level by adjusting the speaker volume. Follow these steps: 

1. On the main NetMeeting menu, click Tools and then click Options. 

2. Select the Audio tab. 

3. Click "Let me adjust sensitivity myself". 

4. Move the slider to the desired position. (Moving the slider to the right will increase the sensitivity.) 

Figuring Out Sound Cards and Drivers

Some of the most common problems encountered when operating the audio feature of NetMeeting are with the sound card 
hardware or software drivers. Most sound cards that you purchase today are compatible with Windows. Any card that says 
Microsoft Sound System compatible or SoundBlaster compatible should work with Windows. If you have any doubt, check the 
manual. A Windows 95 Hardware Compatibility List (HCL) is also available on the Microsoft Web site at 
http://www.microsoft.com/hwtest. In most cases, you may need to get new device drivers from the manufacturer. 

The following section contains some of the most common problems and solutions relating to your sound card and device drivers. If 
you can play and record a WAV file in the Sound Recorder, your audio problems are not related to the sound card or the device 
drivers. 

Note 
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A WAV file is the Windows file format standard for sound files. 

Memory Resident Programs

Other application programs or memory-resident programs that use the sound card can interfere with NetMeeting's audio 
capabilities. Simply quit these applications to enable NetMeeting to use the sound card. Memory-resident programs are generally 
loaded during the boot process of your computer. You can check the AUTOEXEC.BAT, CONFIG.SYS, SYSTEM.INI, and 
WIN.INI files for any programs loading during the boot process that could conflict with NetMeeting. 

Use Current Drivers

The manufacturer's Internet Web site is one of the first places to check when you suspect that the audio problem is related to your 
sound card. Usually you will find the most up-to-date drivers that can solve many problems. 

Some older sound card drivers don't allow NetMeeting to automatically configure the microphone sensitivity settings based on a 
sample that you record. If you are using a sound card that has this older type of software driver, the Audio Tuning Wizard may 
report that NetMeeting does not support your sound card. Your sound card may still function properly, however, and you may be 
able to use NetMeeting's audio features, but you may be not be able to change the microphone volume settings. 

Problems with the Drivers

Sometimes the sound drivers may become damaged, causing the sound card to malfunction. You should verify that the sound card 
drivers you are using are configured correctly and are not damaged. One of the easiest ways to solve this type of problem is to 
simply reinstall the drivers from the disk provided by the hardware manufacturer. 

Before reinstalling the sound drivers, you should remove the driver from the Control Panel by following these steps: 

1. Open the Control Panel by clicking Start, Settings, Control Panel. 

2. Double click on the System icon. 

3. Select the Device Manager tab. 

4. Double-click "Sound, video and game controllers". This will expand a listing of drivers. 

5. Select your sound card driver by clicking it once. 

6. Click the Remove button. 

Conflicting Devices

Installing a sound card into your computer can sometimes cause difficulties because the card may need resources that are not be 
available in your computer. "Plug and Play" is designed to help eliminate resource conflicts, but sometimes it does not work 
properly, or the hardware that you have installed is not Plug and Play compatible. If a resource conflict exists between your sound 
card and another device in your computer, you will most likely have some problems with the NetMeeting audio features. You can 
check whether Windows detects a conflict by opening the Control Panel and clicking the System icon. Then select the Device 
Manager tab. The System Properties screen shows conflicts between devices with a yellow exclamation mark. 

If you are using the full-duplex capabilities of your sound card, this option sometimes can cause a conflict because a sound card set 
in full-duplex audio requires more resources than one set in half-duplex. 

To determine whether the problems are due to the fact that you are using a full-duplex sound card, simply disable full-duplex audio 
in NetMeeting. You can do this by clicking on the Tools Options menu, clicking the Audio tab, and clicking the "Enable full 
duplex audio so I can speak while receiving" check box to clear it. If disabling full-duplex audio corrects the problem, then most 
likely there is a resource conflict between the sound card and another device installed in your computer. You can fix this problem 
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by configuring the sound card or other device to use different resources that do not conflict. The manufacturer of your sound card 
should have information on changing the required resources of your hardware. 

Note 

The sound card drivers included with Windows 95 do not support full-duplex audio. If your sound card supports 
full-duplex audio, you must use the drivers supplied by the manufacturer. Many manufacturers have full-duplex 
sound drivers available on their Internet Web sites. 

Solving Problems with Full-Duplex Operation
Full-duplex sound cards enable simultaneous processing of sound recording and playback. If you use a full-duplex sound card, you 
can talk into a microphone and simultaneously listen to another NetMeeting participant with your speakers or headphones. 

When you use a half-duplex sound card, you must wait for the meeting participant to finish speaking before you can speak into the 
microphone. When you start a NetMeeting conference, you experience half-duplex audio instead of the full-duplex audio you 
expect. 

The requirements for a full-duplex audio conversation are: 

l Full-duplex sound card 

l Full-duplex sound card driver 

l Full-duplex audio enabled in NetMeeting 

l Necessary speakers/headphones and microphones 

l The other conference participant must also be capable of full-duplex audio 

Sound Card Capability

Determine whether the sound cards and drivers are capable of full-duplex audio and verify that full-duplex audio is enabled in 
NetMeeting on both computers. 

Both participants in the conference must have full-duplex audio capabilities to have a full-duplex conversation. It is possible to 
connect a full-duplex system to one with half-duplex for an audio conference, but the conversation will only be half-duplex. 

Testing for Full-Duplex Audio

Determining whether the sound card and driver support full-duplex audio is fairly easy. You can check whether you can play and 
record audio at the same time using the Sound Recorder. This program comes with Windows 95. If it is not installed, you can use 
the Windows Setup tab in the Add/Remove Programs Properties dialog box in the Control Panel. To determine whether your sound 
card and driver support full-duplex audio, follow these steps. 

1. Click the Start button. From the cascading menu, point to Programs, point to Accessories, point to Multimedia, and then 
click Sound Recorder. 

2. Repeat Step 1 to start a second Sound Recorder session. 

3. In the first Sound Recorder session, play a sound (WAV) file that is at least 30 seconds long. 

4. While the first session of Sound Recorder plays the WAV file, switch to the second session of Sound Recorder and record a 
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WAV file. 

If you can record a WAV file while the other WAV file plays, your sound card and drivers support full-duplex audio. If you cannot 
record a WAV file while another WAV file plays, there is a problem in one of the following areas: 

l The sound card does not support full-duplex audio. 

l The sound card driver does not support full-duplex audio. 

l The sound card or sound card driver is not properly configured to support full-duplex audio. 

Full-Duplex Configuration Options

The Audio Tuning Wizard included with NetMeeting can determine whether a sound card supports full-duplex audio. This tool 
does not enable full-duplex audio by default, however. 

To verify whether full-duplex audio is enabled in NetMeeting, follow these steps. 

1. Click Options on the Tools menu. 

2. Click the Audio tab and make sure the Enable Full Duplex Audio check box is selected. 

Other Full- and Half-Duplex Audio Considerations

If one party is full-duplex-capable and the other party is half-duplex-capable, the full-duplex audio party can send and receive 
simultaneously, though the half-duplex audio party cannot. This means that if both parties are talking (sending) at the same time, 
the full-duplex audio party will hear (receive) what the half-duplex audio party is saying while the half-duplex audio party will not 
hear (receive) anything. Both parties will have to adjust to what is effectively a half-duplex conversation. 

A common technique is to say "Over" or "Your turn" or "Back to you" when you have finished talking. Keep each turn fairly short 
(under 30 seconds) so the other party can get a chance to respond. 

Suppose a full-duplex audio party is talking and a half-duplex audio party is receiving and everything seems to be working. Also 
suppose that the full-duplex system does not have the audio sensitivity tuned correctly for the current environment, or the audio 
environment changes. This can happen if there is a change in background noise from when the Audio Tuning Wizard had originally 
set the audio sensitivity; for example, a radio or television is playing nearby, an air conditioner or heating fan turns on, a quiet 
discussion starts in the background, a door opens letting in traffic sounds, and so on. 

At this point, the full-duplex audio party stops talking, but the microphone picks up the ambient noise and sends it. Because the 
full-duplex system is still sending, the half-duplex system will not switch from receive to send mode. The sound may not be loud 
enough to be audible to the half-duplex audio party. The solution is for the full-duplex audio party to run the Audio Tuning Wizard 
again so that the other user can retune sound sensitivity for the current audio environment, including current ambient noise levels. 

Fixing Poor Audio Quality
When you participate in an audio conference with Microsoft NetMeeting, you may experience various audio problems, including 
poor audio quality, voice distortion, echoing, or sound loss. Audio quality can be influenced by any of the following conditions: 

l Poor sound card quality or a malfunctioning card. 

l Poor microphone quality or a malfunctioning microphone. 

l Incorrect Microphone sensitivity (usually set by the Audio Tuning Wizard). 

l Wrong network connection speed (usually set by the Audio Tuning Wizard). 



file://C:\TEMP\~hhB445.htm

Tuesday, August 29, 2000 09:47:27 7 of 27

l Incorrect type of audio compression. 

l Not enough CPU speed/power. 

l Other programs running in memory. 

l Full-duplex versus half-duplex audio conference. 

l A simultaneous video conference or data conference. 

l Limited bandwidth from your Internet service provider. 

l One of the meeting participants may have the microphone positioned too close to the speakers. 

l The computer has more than one audio device. 

Other processes involved in NetMeeting can affect audio quality and general performance. Sharing several programs while 
simultaneously running Whiteboard and Chat and performing a large file transfer will affect available bandwidth for audio, as well 
as consume memory. To improve audio quality, try the following: 

1. Close unnecessary programs that are running. 

2. Reduce the number of shared programs. 

3. Close unnecessary windows, including Chat or Whiteboard. 

4. Postpone large file transfers. 

Choppy full-duplex sound may indicate that the sound card cannot simultaneously send and receive audio signals. Try switching 
NetMeeting to half-duplex audio sound quality. Full-duplex audio can require both more bandwidth (a faster connection) and more 
processing power (a faster computer) than half-duplex audio and may result in poor sound quality. 

Voice distortion may be caused by talking too close to the microphone or by the microphone's sensitivity. First try speaking a little 
further away from the microphone. Ask the other conference participant to let you know if your audio sounds better. If this does not 
help, you might need to adjust the microphone sensitivity setting by running the Audio Tuning Wizard again or manually adjusting 
the microphone sensitivity. Have the other participant move the microphone away from the speakers. Decreasing the volume of the 
speakers may also help. 

There may have been a change in the background noise levels since the Audio Tuning Wizard was last run, so run the Audio 
Tuning Wizard again to readjust the levels. 

Running audio and video simultaneously on a computer with a slower processor may also impact audio quality. Try turning off the 
video, or reducing the image quality you are receiving. 

Your Internet service provider may have limited bandwidth, use a proxy server of some kind, or may have periods of peak usage. 

Audio interference may be generated by other hardware in your computer. Try moving your sound card to a slot away from video 
cards or fans; they may cause playback problems with sound cards. Run NetMeeting in a quiet environment. This problem is 
especially true on laptops in which the microphone is located near the cooling fan. The only solution for this problem is to use an 
external microphone, if your laptop has a microphone jack. 

Using the Audio Tuning Wizard

As mentioned earlier in this book and this chapter, the Audio Tuning Wizard determines whether full-duplex audio is available, 
specifies the recording and playback devices, and enables you to specify the network connection speed and set the microphone 
sensitivity. 
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Note 

You cannot use the Audio Tuning Wizard during a conference, so leave the conference first and then run the Audio 
Tuning Wizard. You can then rejoin the conference once the Audio Tuning Wizard is complete. 

If your computer has more than one audio device, make sure that the audio devices selected in the Audio Tuning Wizard match the 
selections in the Multimedia tool in Control Panel. If the Audio Tuning Wizard indicates that your sound card is not supported, you 
may be able to use the NetMeeting audio features but may experience poor audio quality. As a quick refresher, we'll walk through 
using the Audio Tuning Wizard again: 

1. In NetMeeting, click Audio Tuning Wizard on the Tools menu. 

2. Follow the instructions on the screen. 

To switch to half-duplex audio, follow these steps. 

1. In NetMeeting, click Options on the Tools menu. 

2. Click the Audio tab, then click the "Enable full duplex audio so I can speak while receiving audio" check box to clear it. 

To manually adjust microphone sensitivity, follow these steps. 

1. In NetMeeting, click Options on the Tools menu. 

2. Click the Audio tab and, in the "Microphone sensitivity" area, click "Adjust sensitivity automatically (recommended)". If 
this option is already selected, click "Let me adjust sensitivity myself". 

3. Adjust the Sensitivity slider. 

If you move the slider to the right, your voice will be transmitted earlier (there will be no delays after you speak) and will be less 
likely to cut out, but you might transmit background sound when you are silent. After you adjust the setting, speak a few sentences 
and wait for feedback from a conference participant before changing the setting again. 

If the sound continues to worsen, run the Audio Tuning Wizard again to reset your audio values. 

Avoiding Echo

When you speak into a microphone during a NetMeeting conference to a participant who is using a full-duplex sound card, your 
voice may echo back through your speakers or headphones. This can happen when one participant's microphone is positioned too 
close to his or her speakers. To rectify this, the other NetMeeting participant can 

l Move his or her microphone away from the speakers 

l Decrease the volume of the speakers 

l Adjust the sensitivity of his or her microphone 

l Run the Audio Tuning Wizard to automatically adjust the volume levels 

l Disable the use of full-duplex audio drivers 

l Use a headset 
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From Here . . .
This chapter has shown you how to fix most any problem that can occur with your sound card and how to improve the quality of a 
NetMeeting audio conversation. If you still have audio problems, you should seek help from the manufacturer of your sound card. 

Refer to the following chapters for additional troubleshooting tips: 

l Chapter 16, "Troubleshooting Video," covers finding and fixing problems associated with the video component of 
NetMeeting. 

l Chapter 17, "General Troubleshooting Techniques," will help you with general NetMeeting problems that are not covered 
in the audio or video troubleshooting chapters. 

Chapter 16 

Troubleshooting Video
In this chapter, you will learn: 

l How to solve general problems with video. Video is one of NetMeeting's most interesting and complex features; 
therefore, setting it up can require some troubleshooting. This chapter will help you solve the most basic problems 
encountered when adding video to NetMeeting. 

l How to improve performance. Once you've configured NetMeeting's video to work properly, you'll learn how to make it 
operate more efficiently as well. 

l How to increase video quality. You'll also learn how to improve the video image quality and frame rate. 

This chapter helps you diagnose and solve most problems related to the video features of NetMeeting, including common hardware 
problems and quality issues. If you need help using the video features, first take a look at Chapter 7, "Video Conferencing." You 
can find some good information about the entire video process in that chapter to help you with configuration and setup. 

Unfortunately, there is no online troubleshooting guide built into NetMeeting for the video features. This is most likely because 
video is such a new addition to the product. Setting up the video is actually easier than the audio, even though it is a more complex 
process. There are fewer options and settings for video. 

This chapter will especially focus on the subject of video capture. There are many types of video capture devices on the market that 
range in price and capability. If you are having trouble getting your video capture device to function with the software that came 
with it, then you should reference the user's manual for the device or contact the manufacturer. 

Solving General Video Problems
Your video equipment is installed and you are ready to try out your "new toy," but you find out that you cannot send or receive 
video. This could be for a number of reasons. You may have a hardware compatibility, software driver, or configuration problem. 
Another possibility is that your computer is too slow to process video. The minimum requirement to send video is a Pentium class 
computer. 

You also may have a network bandwidth problem (trying to send more data than the network can handle). Finally, remember that 
video is only supported between two participants in a meeting. 

If you are having any of these problems, you should walk through the various problem areas that might affect the video features. 
We'll look at these in turn in the following sections. After troubleshooting each area, check to see if you resolved the problem. 
Don't forget that the manufacturer has provided you with a user's manual that may contain some valuable information about getting 
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your capture card to function. Some manufacturers may even address NetMeeting directly. 

Note 

If you cannot use the audio features of NetMeeting, you will not be able to use the video features either. 

Video Configuration Options
If you want to send and receive video then you have to turn on those features. You can easily verify that you have enabled the 
video features on the NetMeeting Options page, as show in Figure 16-1, by following these steps: 

1. Click Tools, and then Options from the main menu. 

2. Click the Video tab. 

3. Look in the Sending and Receiving Video area and verify that "Automatically send video at the start of each call" and 
"Automatically receive video at the start of each call" are enabled. 

 

Figure 16-1. Enabling the video features of NetMeeting. 

Verify that the sound card and video equipment installed in your computer are compatible with Windows 95 or Windows NT. To 
use the video features of NetMeeting 2.0 and later, you need a supported sound card and a video capture device like a parallel 
(printer) port camera or a video capture card. The Hardware Compatibility List (HCL) for Windows 95 or Windows NT contains a 
list of computer systems and peripheral devices that are identified as compatible. You can find this list on Microsoft's Web site at: 

http://www.microsoft.com/isapi/hwtest/hcl.idc 

If multiple video devices are installed on your computer, NetMeeting might not recognize one or more of them. Windows can use 
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only one video capture device at a time, but you can have multiple devices installed at the same time. NetMeeting will allow you to 
choose the active capture device on the Video Options tab. You can also check the status of the capture driver through the Control 
Panel in the Multimedia Properties, as shown in Figure 16-2. If you previously uninstalled another capture driver, it is possible that 
the uninstall did not remove the capture driver from the registry. In this case, you can manually delete it in the Advanced area of 
the Multimedia Properties. To see the advanced options of the Multimedia Properties, you need to perform the following steps: 

1. Open the Control Panel by clicking Start, Settings, and Control Panel. 

2. Double-click the Multimedia icon. 

3. Select the Advanced tab. 

4. Double-click Video Capture Devices. 

 

Figure 16-2. Advanced Multimedia Properties shows you all multimedia devices. 

If there are no drivers listed under Video Capture Devices, the drivers for your capture card have not been installed properly or are 
not compatible with Video for Windows. Try reinstalling the drivers that came with the capture device if this is the case. The 
capture device must be listed in the Advanced section of the Multimedia Properties for NetMeeting to use the video capture device. 
If you have installed the drivers for your capture device and it is not listed then your device is not compatible with Video for 
Windows. 

You also can check the status of the device driver by selecting the device and clicking Properties. This displays a dialog window 
that shows if the driver is enabled or not, as shown in Figure 16-3. You also can click the Settings button for more information 
about your device and additional settings. Note that some manufacturers do not support the Settings button, and it may be disabled. 
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Figure 16-3. Video Settings shows the current status of the video device driver. 

The Camera Is Not Responding

If you receive a message that the camera is not responding, this means (in most cases) that the drivers are installed properly, but the 
camera may not be connected. This is a simple problem to fix. Just plug in the camera. You may have to restart NetMeeting. If you 
know that the camera is disconnected and you want to get rid of the message, you can simply disable NetMeeting's video features 
on the Video tab of the Options page. 

My Video Window Is Black

The My Video window is a preview of the local video and is a good indication of whether a video capture device is functioning. 
The My Video window could be black for any of the following reasons: 

l Your camera is turned off. 

l The video capture device is configured to use an unsupported video format. 

l The video capture device does not support Microsoft Video for Windows. 

The first problem is easy to fix, you just have to turn on the camera. However, the other two may be more tricky and are related. If 
your capture card is compatible with Microsoft Video for Windows, it should support one of the following formats: RGB4 (16 
colors), RGB8 (256 colors), RGB16 (65,000 colors), RGB24 (millions of colors), or YVU9 (Indeo Raw Format). These are the 
formats of the video frames that are sent from the capture driver software to NetMeeting. NetMeeting also supports these standard 
formats but if the data uses a different format, NetMeeting won't know how to display the data on the screen. Thus, you may have a 
black screen. You can set the video format by using the configuration program that came with the video capture card. You also 
may want to verify that the capture device is compatible with Video for Windows before you buy it. Most manufacturers display 
this prominently on the packaging to make sure you know it will work with your system. 

Performance Issues
The performance of the video is always a big concern when using NetMeeting. You might expect the video to look similar to the 
quality of your television, but as explained in Chapter 7, "Video Conferencing," this is simply not possible in most cases because 
you are limited by bandwidth. Bandwidth is the amount of data that you can transfer through the network, and in most cases, it can 
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be a precious commodity. You can, however, control the amount of bandwidth used and improve the performance. Usually there is 
a tradeoff between image quality and motion. If you require high image quality (high-resolution frames), you may not get fluid 
motion in the image, but if you require a high degree of motion (high frame rate), then most of the time the image quality may be 
lower and the video may appear "blurry." 

The following will affect the performance of the video features of NetMeeting: 

l Processor type. Pentium, Cyrix 586, or AMD K6 is recommended but MMX is even better. 

l Available bandwidth. ISDN is great. A 28.8 modem (or higher) will work, too. Using a 14.4 modem is definitely not 
recommended. 

l Type of video capture device. Capture cards are better than parallel and serial port cameras. 

l Operating system. Windows 95 may be faster than Windows NT, depending on hardware configuration, memory, and the 
number of services running. 

l Size of video. The smaller the video, the faster. 

l Amount of video scaling. A size of 100 percent is the most efficient. 

l Image complexity. Solid background and solid clothing work best. 

l Amount of movement. More movement causes more data to be transmitted. 

l Compression amount. More compression is faster but "blurry." 

l Lighting. Good lighting helps video performance and quality. 

Also consider that there may be a lot of traffic on the Internet or on your network during your NetMeeting conference. If you use 
the Internet at 2:00 am you will find that it is much faster than at 8:00 in the evening when everyone is home browsing. If you are 
using a commercial online service such as CompuServe or America Online, you may always experience performance problems, 
because their systems are not designed to handle a constant stream of data going in both directions. 

Slow Video

The speed of your computer's processor and the type of video equipment you are using can affect video performance. Computers 
with a bi-directional (ECP or EPP) parallel port perform noticeably better with parallel video cameras than computers with a uni-
directional parallel port. Most new computers come with bi-directional parallel ports. You have to go into the system BIOS settings 
to see if you have the port set to this mode. Your computer should tell you during boot up how to access the system BIOS. You 
typically have to press the Delete or Escape key during the memory test to enter the system BIOS settings. In the Peripheral setup, 
you should see a setting for the parallel mode. If you do not see this option, then your computer does not support this type of port. 

Additionally, if you use NetMeeting's video features in a dark area, some cameras might cause your computer to become extremely 
slow and unresponsive. This is due to additional processing that may be required because of the low-light conditions. Try closing 
other applications or minimizing the My Video window to improve video performance. Also, you might improve performance by 
reducing the video quality, which increases the compression and frame rates. Figure 16-4 shows the Video tab on the Options 
dialog. To change the video quality, follow these steps: 

1. On the main menu, click Tools and and then click Options. 

2. Select the Video tab and move the "Video quality" slider to change the amount of compression. 

Note 

Cameras that connect to a video capture card use less of your computer's processor than cameras that connect 
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through your computer's parallel port. 

 

Figure 16-4. Setting the video quality and compression. 

For higher frame rate but lower-quality (blurry) images, increase the compression and frame rates by moving the slider toward low 
(to the left). For slower performance but higher-quality images (clearer), decrease the compression and frame rates by moving the 
slider toward high (to the right). Note that this setting only affects the video quality received by you. You cannot control the quality 
of the video that you send. 

Poor Video Quality During a Conference

If the quality seems to be poor in the video windows during a conference, any of the following may be the culprit: 

l You have selected to transmit a large image size and the computer cannot process the video fast enough. 

l You have selected to transmit a large image size, but there is not enough available bandwidth. 

l The video quality is set to low, which is the default setting if you selected a 28.8 Kbps modem during the setup. 

l You may not have enough light in the area. Good lighting around the subject always helps the quality and the performance. 

l You are doing large file transfers or sharing applications that are taking up the bandwidth of your connection. Your 
bandwidth is shared between all of NetMeeting's features. 

Make sure that there is sufficient lighting for the camera. Then, try closing other applications to improve image quality. Also, you 
might improve image quality by changing the size of the image. On a computer using a slower processor, smaller images process 
better than larger images. 

To change the image size you need to change the video options in the NetMeeting Options dialog, shown previously in Figure 16-
4. Follow these steps to change the image size: 
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1. On the main menu, click Tools and then click Options. 

2. Select the Video tab. 

3. In "Send image size", select the desired size. 

From Here . . .
This chapter discussed how to fix some of the common problems with video capture devices and NetMeeting. You also learned 
how to increase the performance and quality of a video conference. 

If you are still having trouble, you should refer to the following chapters or contact the manufacturer of your capture equipment. 

l Chapter 7, "Video Conferencing," discusses the entire video process and how to use the video features of NetMeeting. 
Understanding how this process works can help you solve problems when they happen. 

l Chapter 15, "Troubleshooting Audio," focuses on fixing problems with the audio component of NetMeeting. Audio and 
video trouble can be related, so check out this chapter for help. 

l Chapter 17, "General Troubleshooting Techniques," covers general troubleshooting with NetMeeting. 

Chapter 17 

General Troubleshooting Techniques
In this chapter, you will learn: 

l The basics. Learn the basic strategies to solve almost any NetMeeting problem. Discover the best way to search for, 
identify, and isolate the problems that keep NetMeeting from running smoothly. 

l Common problems. You'll find solutions for the most common problems, from downloading, installation, and setup, to 
font troubles and SpeedDial shortcuts. 

l Networking problems. Problems bring NetMeeting to a halt. Is your directory server down? Could it be an invalid IP 
address? Read this section to help pinpoint your network configuration problems. 

l NetMeeting feature trouble. NetMeeting's sophisticated features may take some tweaking. Difficulties relating to 
application sharing, file transfer and the Whiteboard are examined. 

Getting every piece of NetMeeting to work the first time may not be possible for some people. If you are reading this, you are 
probably one of those users. There are so many options and features that it's easy for something to go wrong. This chapter is 
designed to help you figure out the most common problems that people have with NetMeeting. I also go through some basic 
troubleshooting strategies that can help you determine and solve almost any problem with NetMeeting. 

Tip 

If you are having trouble with NetMeeting's audio or video features, I suggest that you refer to Chapter 15, 
"Troubleshooting Audio," or Chapter 16, "Troubleshooting Video." 

Troubleshooting 101
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You can follow some basic steps to troubleshoot NetMeeting problems. Troubleshooting is considered an art form by many people, 
and troubleshooting software is no different. These tips will not only help you solve problems with NetMeeting, but they can be 
applied to almost anything. I bet you didn't think this book would help you so much when you picked it up. Here are the basic steps 
that you should follow to solve any problem with NetMeeting: 

1. Identify the problem at hand. This can be as simple as "It just won't connect." 

2. Check whether the problem is discussed in this chapter or in the other troubleshooting chapters. Also check the online 
Troubleshooting Guide that is part of NetMeeting. 

3. If you have several problems, isolate one problem at a time and test the conditions that cause it to occur. 

4. If you cannot fix the problem, check the online knowledge base and support. See Appendix B, "Additional Online
Information" for a list of online support options. 

Identify the Problem at Hand

Determining the exact nature of the problem can be a simple but crucial part of starting the troubleshooting process. If you don't get 
this part right, then the rest of the steps are pointless. Why solve the wrong problem? Consider the following when you start 
troubleshooting any problem with NetMeeting: 

l Are you presented with any error messages? 

l At what point of your work with NetMeeting does the problem happen? 

l Can you reproduce the problem or does it happen randomly? 

l Is the problem specific to a NetMeeting feature like audio, video, or application sharing? 

l Do other applications have the same problems? 

l Have you changed the hardware configuration of your computer? 

l Have you changed any of the settings on your computer? 

l Have you installed any other new software? 

l Did NetMeeting work before? If it did, what might have changed? 

l Does your computer meet the minimum hardware system requirements for NetMeeting? Refer to Chapter 2, "Preparing
Your System," for system requirements. 

Checking for Common Problems

Check whether the problem is commonly reported and described in this or the other troubleshooting chapters (Chapter 15 and 
Chapter 16) or in the online help for NetMeeting. The NETMEET.TXT file, which is installed in the NetMeeting folder, contains 
the most recent bug reports and known problems with the latest version of NetMeeting. You can view this file with Notepad. The 
online help also includes several troubleshooting aids for solving common NetMeeting troubles. To access the online 
troubleshooting help, follow these steps: 

1. On the main menu of NetMeeting, click Help, then Help Topics. 

2. Select the Contents tab and click Troubleshooting, then Open. 

3. Next, select "If you have trouble using NetMeeting" and click Display. 
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4. Click the appropriate button that describes your problem. 

Isolating the Problem

It is easier to deal with one problem at a time. One key to good troubleshooting is narrowing down a big problem to many little 
ones or isolating several problems that happen at the same time. You can resolve a problem more quickly by systematically 
isolating and testing the error conditions. You can use the following methods to help you isolate the error conditions: 

l Eliminate other external variables. You may want to close all other running applications so that you can eliminate the 
possibility that they are interfering with or causing the problem in NetMeeting. 

l Isolate the cause by changing a specific configuration value and testing whether the change makes any difference. A good 
example is switching between full- and half-duplex audio to resolve audio problems. 

l If the software fails after you have added new hardware or software, remove the new hardware or uninstall the software to 
see whether that solves the problem. A common problem is adding a new video capture card that conflicts with other 
hardware in your system. Take it out and verify whether it is, in fact causing the problem. 

Test each modification individually to see whether the change resolves your problem. Make note of all modifications and their 
effect on symptoms. If you contact product support personnel, this information helps them troubleshoot your problem. Also, the 
information provides an excellent reference for future troubleshooting. 

Check Online Troubleshooting and Support

A variety of online support options are available to you. Other users may have discovered the same problem that you are having, 
reported it, and found solutions. It will save you time if you use this valuable resource to resolve problems with NetMeeting. You 
can access the online support page by following these steps: 

1. On the main menu, click Help. 

2. Click Online Support and the Technical Support page will display in your Web browser. This page contains the most 
updated information about troubleshooting and other online support options. 

Web Alert 

The link for the online support page is: http://www.microsoft.com/iesupport/netmeeting/. 

Common Problems, Questions, and Issues
This section describes common problems that NetMeeting users have reported and provides helpful information for responding to 
problems, questions, and issues. Remember that for a conference to begin, you and the person whom you are calling must: 

l Have an active connection to the Internet or a shared corporate network; 

l Run NetMeeting on your computer; 

l Allow NetMeeting to accept calls and manually accept the call when it comes in. 

Another T.120-Compliant Conferencing Application Is Running

NetMeeting conforms to the International Telecommunications Union (ITU) T.120 conferencing specification. It is compatible 
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with other conferencing programs that are based on this specification, but it cannot run while another program based on this 
specification is running on the same computer. If you attempt to start NetMeeting when another T.120-compliant conferencing 
program is running, NetMeeting may stop responding (hang) or the following error message may be displayed: "Microsoft 
NetMeeting cannot start because this computer is already running another conferencing application. Please close the other 
application and try again."

To work around this problem, close all other T.120-compliant conferencing programs before attempting to start NetMeeting. If you 
are not sure whether another T.120-compliant conferencing program is running, close all other programs and attempt to start 
NetMeeting. 

The same error can be caused if NetMeeting terminated abnormally and part of the application is still running. The only way to fix 
this is to reboot your computer and start NetMeeting again. 

Damaged TrueType Fonts

When NetMeeting begins, all of the fonts installed on the computer are processed so NetMeeting can determine how to handle 
fonts that may not be installed on conference participant computers when applications are shared. If any of the TrueType fonts are 
damaged, NetMeeting may stop responding (hang) when you attempt to start it. 

To verify that there are no damaged TrueType fonts, double-click Fonts in Control Panel and then double-click each TrueType font 
in the Fonts folder. If your computer hangs when you double-click a font, that font may be damaged. If you encounter a damaged 
font, drag it from the Fonts folder to another folder. Once you have confirmed that a particular font is the cause of the problem, you 
can delete the font. If the font is required or one you want to use, reinstall the font from the appropriate source. 

Access Violation Error Occurs While Downloading NetMeeting

While you download NetMeeting, you may receive an Access Violation error message. This error can occur if the downloaded file 
becomes damaged. You can resolve this problem by downloading NetMeeting again. If the download seems to finish very rapidly, 
empty your browser's cache and download again. You will then receive a new complete copy of the program. 

Conference Hangs While Close Program Dialog Box Displays

When you are in a conference and one of the conference members opens the Close Program dialog box (by pressing Ctrl + Alt + 
Del), other conference members receive no response from the computer that's displaying the Close Program dialog box. This 
causes all programs to be suspended while the dialog box is displayed. If you need to open the Close Program dialog box, notify 
the members of your conference that you will be unavailable and that they should not attempt to contact you during this time. 

No Error Message but NetMeeting Setup Does Not Finish

When you try to install Microsoft NetMeeting on a drive with insufficient disk space, you may receive the following message: "To 
install this program, you need 14,000 KB disk space on drive C:. It is recommended that you free up the required disk space before 
you continue. Do you still want to continue?" 

If you click Yes, the setup process appears to continue and finish, but the program may not set up successfully. To resolve this 
problem, free at least 16 MB of space on the destination drive, and run NetMeeting Setup again. Installation of NetMeeting will 
place files in your system directory (WINDOWS\SYSTEM) and in the installation directory that you choose. So make sure there is 
space in both areas. 

Cannot Open FrontPage Configuration Files

After you install Microsoft NetMeeting, when you attempt to open a Microsoft FrontPage version 1.x configuration file for editing, 
the SpeedDial tool in Microsoft NetMeeting opens. NetMeeting associates files with a CNF extension with the SpeedDial tool, 
which is the same extension that FrontPage is expecting. To edit a FrontPage configuration file, use any text editor (such as 
Notepad) to open the file. 

Cannot Modify SpeedDial Properties
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When you view the properties for a SpeedDial shortcut in the SpeedDial folder, the only changes you can make are for the file 
attributes. If you need to change the properties for a SpeedDial shortcut, use one of the following methods: 

l Delete the icon from the SpeedDial folder and create a new icon using the Create SpeedDial command on the Call menu. 

l Edit the shortcut by using a text editor, such as Notepad, to open the .cnf file in the SpeedDial folder and edit the 
"Address=" line. 

The format of the Address line is: 

Address=<Server name>/<User address>

The Send to Mail Recipient Option Is Unavailable on SpeedDial Shortcuts

When creating a SpeedDial shortcut, you cannot select the "Send to mail recipient" option. Instead, you can choose only to save the 
shortcut on the desktop. 

This happens if you do not have a mail application program interface (MAPI)-compliant mail client installed. Install a MAPI-
compliant mail client. Examples of MAPI-compliant mail clients include:

l Microsoft Exchange 

l Microsoft Windows Messaging 

l Microsoft Outlook Express 

l QualComm Eudora 

Connecting to the ILS and Other Networking Problems
When you use NetMeeting and try to connect or reconnect to a directory server using an Internet Locator Server (ILS), you may 
receive one or more of the following error messages: 

l "The User Location Server could not be found. Your information will not be available to others." 

l "There was a problem connecting to the Directory Server. Please choose another server." 

However, you may be able to view the directory server with your Web browser. These types of connection problems can be caused 
by any of the following situations: 

l The directory server may be down. 

l You are using a 16-bit Winsock connection to your Internet service provider (ISP). 

l You are connected to the Internet using a proxy server. 

l You recently closed NetMeeting. 

If your directory server is down, try again later or use a different server. If you are using a 16-bit Winsock connection, contact your 
ISP to see whether a 32-bit version is available, or use dial-up networking to establish the connection. 

If you are using a proxy connection, have your network administrator check the proxy settings. Refer to Chapter 11, "Configuring
Corporate Firewalls," for more information on how to configure a proxy server with NetMeeting. Use port 389 for ILS and port 
522 for ULS. If you recently closed NetMeeting, wait a few minutes before attempting to reconnect to the directory server. 



file://C:\TEMP\~hhB445.htm

Tuesday, August 29, 2000 09:47:27 20 of 27

Determining Whether Your Directory Server Is Down

Try to ping the server. When you are connected to your ISP, type 

ping <name of the directory server>

at a command prompt, and press Enter. If you do not get a reply, the directory server may be down, or your Domain Name Service 
(DNS) configuration may be invalid. If you get a reply, try using the Internet Protocol (IP) address as your directory server. 

Determining Whether Your Connection Is 16-Bit or 32-Bit

When you are connected to your ISP, type "winipcfg" at a command prompt, and press Enter. If the information displayed in the 
fields is all zeros when you are connected to your ISP, you are probably using a 16-bit version of Winsock.dll. 

Check whether your ISP can work properly with a 32-bit version of Winsock.dll. If appropriate, upgrade to the 32-bit version. The 
Dial-up Networking tool included with Microsoft Windows 95 and Microsoft Windows NT 4.0 uses a 32-bit connection. 

The ILS Is Unavailable

Be sure to verify whether the ILS to which you are attempting to connect is available before you perform any additional 
troubleshooting steps. To verify whether the ILS is available, contact the ILS administrator or attempt to connect to the ILS from 
another computer that you know can connect to another ILS. 

If the ILS is not available, you may want to configure NetMeeting to use a different ILS. To do so, click Options on the Tools 
menu in NetMeeting, click the My Information tab, and type the name of a different ILS in the Directory Server box. 

Double-Bound TCP/IP Protocol

If you have bound the TCP/IP protocol to both your network card and the dial-up adapter, the multihoming feature of the TCP/IP 
protocol may not function correctly. It may prevent you from connecting to an ILS. To determine whether the TCP/IP protocol is 
bound to your network card and the dial-up adapter, double-click Network in Control Panel. If the list of installed network 
components includes two lines that are similar to the following lines, the TCP/IP protocol is bound to both your network card and 
the dial-up adapter: 

TCP/IP -> Dial-up Adapter

TCP/IP -> Intel EtherExpress Pro 16

To work around this problem, unbind the TCP/IP protocol from your network card before you attempt to connect to an ILS. To do 
so, follow these steps: 

1. In Control Panel, double-click Network. 

2. Click the instance of the TCP/IP protocol that corresponds to your network card in the list of installed components, and 
click Properties. 

3. Click the Bindings tab, click all check boxes on the Bindings tab to clear them, and click OK. 

Caution 

Changing these settings will affect your ability to use your network resources. Check with your system administrator 
if you are not sure about making changes to your network settings. 
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If unbinding the TCP/IP protocol from your network card does not correct the problem, you may want to try using the 
Winipcfg.exe tool to release all IP addresses assigned to the network adapter before you attempt to connect to an ILS. To do so, 
follow these steps: 

1. Click the Start button, and click Run. 

2. Type "winipcfg.exe" in the Open box, and click OK. 

3. Click your network card in the IP Configuration dialog box that appears, click Release, and click OK. 

Recently Closed NetMeeting

By default, NetMeeting sends a termination message on closing that tells the ILS to remove the user name. This normally takes less 
than one minute. If for some reason the ILS does not receive this termination message, your name will remain on the user list for 
about 5 minutes. This can happen if your NetMeeting session ends abnormally or your network connection is interrupted. In both 
cases, NetMeeting never had a chance to send the termination message to the ILS.You cannot reconnect to the ILS until your user 
name has been removed from the listing. 

To work around this problem, wait a few minutes before attempting to reconnect to the ILS server. The ILS will automatically 
remove you from the list if it detects that you are not online after a certain time period. 

An Invalid IP Address

If the saved NetMeeting connection in the SpeedDial refers to an IP address that is no longer valid for the person you are trying to 
call, you will not be able to connect to that person. To work around this problem, connect to the ILS again to find the current IP 
address of the person you want to call. 

After you click a person listed on a ILS using your Internet browser, you have the option to call or save a connection to anyone 
logged into the server. If you choose to save the connection so you can dial it later, NetMeeting creates a file, with an ILS 
extension, that includes the information needed to connect to that person. These saved connections use the IP address of the person 
when they were connected to the ILS. 

Many Internet service providers and corporate networks are configured to use dynamic addressing, which may not assign the same 
IP address to a user each time he or she connects to the Internet or network. This creates an obvious problem with a SpeedDial that 
references a specific IP address. Some Internet service providers can provide you with a static IP address, which eliminates this 
problem. 

Web Directory and NetMeeting Home Page Options Are Not Functional

After starting NetMeeting, you try to click a menu option. Both the toolbar buttons and the menu commands on the Web directory 
and NetMeeting home page do not respond. This can occur if one of the following conditions exists: 

l Your Web browser has not registered itself properly with Windows. 

l Your browser does not support the required Hypertext Transfer Protocol (HTTP) shell extension. 

To solve this problem install an Internet browser, such as Microsoft Internet Explorer, that registers properly and supports the 
HTTP shell extension. This shell extension enables you to access a World Wide Web page by typing an HTTP address from the 
Run command on the Windows 95 or Windows NT Start menu. If your Internet browser registers properly with Windows 95 or 
Windows NT but does not support the required HTTP shell extension natively, you can install Microsoft Internet Explorer to add 
this functionality. By keeping your original browser as the default, you can use the Web directory and NetMeeting home page 
options. 

Dialing and Connecting
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Getting connected to another NetMeeting user can be a difficult problem to solve. This section covers some of the most common 
troubles encountered when trying to connect with someone. Chapter 4, "Making Your First Call," contains more detailed 
information about placing a call and connecting. 

NetMeeting Does Not Accept Incoming Calls

During a NetMeeting session, a dialog box notifies you of an incoming call. One of two conditions might exist: 

l You cannot accept the incoming call by pressing Enter because the NetMeeting window displays an existing dialog box, 
such as Place Call. 

l You cannot accept the incoming call using the keyboard or mouse because another meeting participant currently controls a 
shared program and, therefore, controls keyboard and mouse functions. 

This occurs because of the way Windows processes dialog boxes. The Place Call dialog box is a system modal dialog box that 
requires user input before the system can continue. You must close these modal dialog boxes before Windows allows normal 
keyboard input into nonmodal dialog boxes, such as the dialog box generated by an incoming call in NetMeeting. 

In addition, the dialog box generated by an incoming call might not become the active dialog box if another meeting participant 
controls a shared program. Therefore, you cannot press Enter or use the mouse to accept the call because the other meeting 
participant controls the keyboard and mouse pointer functions. 

If you cannot accept an incoming call because another meeting participant currently controls a shared program, press Alt + Tab to 
switch to NetMeeting, and press Enter to accept the call. You can also configure NetMeeting to accept incoming calls 
automatically. 

To configure NetMeeting to accept incoming calls automatically, follow these steps: 

1. On the Main Menu, click Tools and then Options. 

2. In the Incoming Calls area on the General tab, check the "Automatically accept incoming calls" check box to enable this 
option. 

Note 

You can use the Spacebar to accept incoming calls when another dialog box is open in NetMeeting, but you cannot 
use the keyboard to ignore incoming calls in this manner. You must first close the other dialog box to ignore the 
call. 

The Person You Called Is Not Able to Accept Calls

When you attempt to place a call using NetMeeting, you may receive the following error message: "The person you called is not 
able to accept NetMeeting calls." To place any call, you must have selected an installed, working protocol and an installed, 
working device (such as a modem or network adapter). To resolve this error, check these items: 

l Using standard network troubleshooting methods, verify that the protocol or device required is installed and working. 

l If necessary, install the missing device or protocol and restart NetMeeting. 

When you try to call someone listed on the ILS, you may receive one of the following error messages: 

l "User did not accept your call." 



file://C:\TEMP\~hhB445.htm

Tuesday, August 29, 2000 09:47:27 23 of 27

l "User is unable to accept NetMeeting calls." 

These error messages can occur if any of the following situations exist: 

l You are not connected to the Internet. 

l The other party is not accepting your calls. 

l The person whom you are calling is not running NetMeeting or is not connected to the Internet. 

l NetMeeting has become damaged and needs to be reinstalled. 

Verify that you are connected to the Internet and that the person you are trying to call is also connected to the Internet and running 
NetMeeting. If the problem persists, try to connect with different users. If you are unable to connect with anyone, you may have 
damaged files. Remove and reinstall NetMeeting. 

Windows Attempts to Dial when Started

After installing NetMeeting, you restart your computer and Windows displays a Connect To dialog box instructing you to dial your 
Internet service provider. This occurs when all of the following conditions exist: 

l The "Run when Windows starts and notify me of incoming calls" option is enabled. 

l Your computer is not directly connected to the Internet (that is, you are using a modem for Internet access). 

l Your browser is set up to dial automatically when it starts. 

If you enable the "Run when Windows starts and notify me of incoming calls" option, NetMeeting will load as part of the startup 
procedure and will attempt to locate the ILS server on startup. Windows recognizes the request to connect to the server as an 
HTTP address and starts your World Wide Web browser to make the Internet connection. To resolve this, disable the "Run when 
Windows starts and notify me of incoming calls" by performing these steps: 

1. On the NetMeeting main menu, click Tools, then Options. 

2. In the Incoming calls area of the General tab, clear the "Run when Windows starts and notify me of incoming calls" check 
box. 

Application Sharing
Using the application sharing feature can add a lot to a NetMeeting session, but it can also introduce a set of problems. This section 
covers problems that can occur when you use this feature of NetMeeting. Refer to Chapter 8, "Application Sharing and File
Transfer," for additional information about how to use application sharing during a conference. 

Programs Inadvertently Shared when Sharing Windows Explorer

When you share an instance of Windows Explorer, Control Panel, Briefcase, My Computer, or another Windows Explorer-based 
program with Microsoft NetMeeting, all Windows Explorer-based programs that are currently running are automatically shared. In 
addition, after you share a Windows Explorer-based program with NetMeeting, any other programs that you start are automatically 
shared. To work around this problem, use one of the following methods: 

l If a program that you do not want to share is automatically shared, manually stop sharing it. To do so, point to Share 
Application on the Tools menu, and click the program that you want to stop sharing. 

l Do not share Windows Explorer during a NetMeeting session. 
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Sharing Full-Screen and Graphics-Intensive Programs

When you share a graphics-intensive program with Microsoft NetMeeting, the program may not display properly on other 
computers participating in the meeting. In addition, when you share a program that is running in full-screen mode, the program may 
appear differently on other computers participating in the meeting. The program may not display properly, or the program's 
window may be minimized. 

Many video clips, graphics-intensive games, and other programs based on DirectX, DirectDraw, OpenGL, Video for Windows, or 
other similar technologies do not display properly when shared with NetMeeting. This known limitation of NetMeeting is most 
likely to occur when a video clip or graphics-intensive game or other program runs in a full screen, but it can also occur when the 
video clip or program runs in a window. 

When a shared Windows-based program (such as Microsoft 3D Pinball) runs in full screen mode, NetMeeting will display a 
program window to all of the other computers who are in the meeting. If the Windows-based program is graphics-intensive, 
however, the contents of the Window may not be displayed properly to all of the participants because of the volume of information 
that must be transmitted. When a shared MS-DOS-based program (such as the MS-DOS Editor) runs in full screen mode, the 
window will be shown as a minimized program on the participating computers. So the full screen MS-DOS program will not be 
displayed to the members of the conference. 

If you are unable to reliably share a particular video clip, graphics-intensive game, or other program, you should not share the 
video clip or program using NetMeeting. 

Slow Performance in NetMeeting when Sharing Graphics

When you share a program that uses a large number of graphics, you may notice a decrease in performance that worsens with the 
number of members in the conference. This is due to the amount of information that must be transmitted to the participants. 
NetMeeting intercepts calls made to GDI, the Windows Graphical Display Interface, and transmits them to the other members of 
the conference. In this process, graphical resources are used and may slow the performance noticeably, depending on the amount of 
information being intercepted and transmitted. Use any of the following methods to improve performance: 

l Decrease the number of participants. 

l Increase the network speed. You can use a faster modem or lower the amount of traffic on the network (this may not be a 
practical solution). 

l Close all unneeded programs that are running. 

Sharing Programs Enables Other People to Access Your Files

NetMeeting enables you to share a program with other people in an online meeting. Depending on the program you share, their 
ability to use the from your hard disk when using a program on your computer, the other participants can also open files from your 
hard disk when using the same program from their computers. 

When you share a program in Microsoft NetMeeting and use the collaboration capabilities, other meeting participants can access 
files on your hard disk. Their ability to access your files might include the ability to create new files or open, modify, move, or 
delete existing files. Other meeting participants can access your files in this manner, regardless of whether you share the files on 
your computer. 

Other participants can use features of the shared program to control hardware devices (for example, to print a file); however, they 
cannot share applications that report status for these devices (for example, the Background Print Monitor). Because sharing a file 
on your hard disk does not affect your ability to access the file locally, another person can access the file when you share a program 
with NetMeeting. You can take precautions to prevent additional access when sharing an application: 

l You can stop someone from using your shared program while you do not have control of the cursor by pressing the Escape 
(Esc) key. 
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l Don't leave your computer unattended while you are in a session in which application sharing is enabled. 

You Are Unable to Save Files in a Shared Application

During a conference, you can view and update a file shared by another participant, but you cannot print the file or save it to your 
own computer. This is because these functions only work on the computer that shared the application. To resolve this situation, ask 
the person who shared the program to send a copy of the file to everyone in the meeting. To send a copy of the file to all meeting 
participants, follow these steps: 

1. On the main menu, click Tools, File Transfer, and Send File. Or you can press Ctrl + F to accomplish the same thing. 

2. Send the file to all or select the names of the participants whom you want to have the file. 

3. Locate and select the file you want to send. 

4. Click Send. 

Also, you can transfer a file by dragging the file's icon onto the NetMeeting main window. After you transfer a file, recipients see a 
standard warning dialog box that provides the following options: Open, Close, and Delete. If a participant accepts the file, the 
default destination is the PROGRAM FILES\NETMEETING\RECEIVED FILES folder. 

Part of the Shared Window Is Masked

During a conference, you view a shared application from another participant. A bitmap window covers part of the shared 
application window, masking your view of the shared information. The person sharing the application has a second, unshared 
window covering the shared window. To prevent this problem, keep overlapping windows to a minimum. See Chapter 8 
"Application Sharing and File Transfer," for an example of this behavior. 

File Transfer
This section covers some of the problems that you might encounter when using the file transfer feature of NetMeeting. You can use 
this feature to send files to the participants of a meeting. You may also want to consider using a virus scanner, such as McAfee 
VirusScan on any files that you receive during a NetMeeting session. 

Unable to Receive Files Using File Transfer

You might receive the following error message on the sending computer: "There was a problem transferring the file." This 
behavior can occur if either of the following conditions exists: 

l NetMeeting is configured to receive files on a mapped network drive or removable media, and you do not have the ability 
to write to that network drive or removable media. 

l There is not enough free disk space for the file. 

The solution in this case is to change the location where files are received. To do so, follow these steps: 

1. On the Tools menu, click Options. 

2. On the General tab, change the setting in the "Save files sent to me" in the dialog box to a folder you can write files to. 

The default folder for incoming files is: 

PROGRAM FILES\NETMEETING\RECEIVED FILES



file://C:\TEMP\~hhB445.htm

Tuesday, August 29, 2000 09:47:27 26 of 27

If you change this folder, make sure there is enough free space and that you can write files in the folder. If you select a folder on a 
removable media, make sure the appropriate media is inserted when the file transfer is started. 

Troubleshooting the Whiteboard
The Whiteboard allows a group of people to mark on a common space using text, brushes, and other graphical objects. This section 
covers some of the problems that can arise when you are using this feature of NetMeeting. For more information about this feature 
refer to Chapter 5, "Chat and Whiteboard." 

Pasting a Bitmap into the Whiteboard Might Alter the Image

When you paste a bitmap into the NetMeeting Whiteboard, the image might appear damaged or altered from the original version. 
Some color intensive bitmap images might not display well on the Whiteboard, but the actual image file is not damaged. Try 
sending the graphic file to the members of the conference to correct the problem. They can then use another program such as 
Internet Explorer to display the graphic file. 

Text in Whiteboard Is Not Visible

When you type text in the Whiteboard tool, the text may not be visible if you place the mouse pointer near the top of the 
Whiteboard screen. After you click the Text button, move the mouse pointer away from the top of the Whiteboard screen. The text 
will then remain visible as you type. 

Unpredictable Colors when Using the Highlight Pen

When you use the Whiteboard highlight pen, you might experience the following symptoms, depending on the combinations of 
colors used: 

l Your pen might not overwrite the highlight color drawn by another participant. 

l Your pen might not appear to work or might change the colors of a bitmap to a dark color. 

These problems occur because NetMeeting optimizes the Whiteboard tool for a yellow highlighter on a white background. The 
best solution is to experiment with different colors to find combinations that work for all participants without affecting the 
usefulness of the Whiteboard tool. If you often use a bitmap on the Whiteboard, you might find that bitmaps with white 
backgrounds produce better results when you use the highlighter pen. 

Cannot Open a Saved Whiteboard File

When you double-click a saved Whiteboard (.wht) file or use the right mouse button to click the file and then click Open, the file 
may not open. When this occurs, you receive no error message. This is because the Whiteboard tool is already running. By design, 
you can run only one instance of Whiteboard at a time. To open a saved Whiteboard file, use one of the following methods: 

l Drag the Whiteboard file to the open Whiteboard session. 

l Switch to the current Whiteboard session by clicking its icon on the taskbar, click Open on the File menu, click the file you 
want to open, and then click Open. 

l Close the current Whiteboard session, then double-click the Whiteboard file you want to open. 

From Here . . .
This chapter covered problems commonly encountered with many of NetMeeting's features. Hopefully, you found the problem that 
you were experiencing and it has been resolved. If not, check the chapter relating to the feature that you are having trouble with. 
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You may want to check the following chapters for additional detailed troubleshooting information on video and audio: 

l Chapter 15, "Troubleshooting Audio," focuses on solving problems relating to the audio feature of NetMeeting. If you are 
having trouble sending or receiving audio then you should read this chapter. 

l Chapter 16, "Troubleshooting Video," covers the problems and solutions for the video feature of NetMeeting. 


